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INTRODUCTION

WHAT IS FLASH?

Macromedia Flash is an animation and web-authoring tool that can create a special type of file called a "Flash movie" and has ".swf" as its extension. You can see this type of movie more and more in common pages on the Internet, and sometimes see a as Flash movie as an animated banner or an electronic greeting card.

DRAWING IN FLASH

It is quite easy to build cartoon style graphics in Flash because the drawing tools are quite versatile. You can also draw more "serious" graphics like flowcharts or organisation charts.

Unlike other drawing tools for the Internet, Flash stores all graphics in a vector format, allowing them to be without losing quality or detail. If you draw a small circle in a program like MS PaintBrush, when you try to resize it by 200% you will see jagged edges in the circle and it will look “pixilated” or made up of pixels (dots). This is, because PaintBrush stores a shape like a circle as single "pixels" or dots, and if you resize the circle, all these pixels will be resized too. In Flash, the circle is stored as a mathematical or formula representation of a circle. The location and size of the circle is stored along with the color. If you resize the circle to 200%, only the stored size will be increased and the circle will be drawn perfectly in a larger size. 

WHAT IS MULTIMEDIA?

Multimedia refers to an application that contains a number of media such as -  animation, text, graphics, video and sound. Flash can create multimedia very well. If you have created your graphics in Flash, you will be able to move these on the "stage". The graphics are placed on the stage and then instructions given to tell the program if and when they should move. You have a "timeline" where you do control the timing of the animation, and you have "keyframes" where you do control the position of the objects on the stage.

You can also play sound within your movie. Flash supports all common sound formats like "wav" and "mp3". You can import the sounds and assign them to your "actors" on the stage. With this ability, you can accompany your animation with a suitable sound, or you can even play a recorded narration to explain something.

Flash can use streaming technique to play the sound, so there is no need to load the full sound into the memory of your computer. Especially, if you use large sound files, this will come in handy when the movie is distributed over the Internet.

USER INTERACTION

Flash contains a powerful programming language called "ActionScript". ActionScript allows you to  build movies that can interact with the viewer. This is useful if you want to build a quiz, a game, a shopping cart or a client feedback form in Flash. We will use Basic commands like STOP to stop animation at a particular frame.

ActionScript is just like HTML or JavaScript but more powerful. You can use it to control your animations interactively by adding actions to particular keyframes. A detailed look at ActionScript is beyond the scope of this booklet. See Internet Tutorial Sites or refer to books like Flash ActionScript for Dummies, The Flash Bible, or Flash Visual Quickstart Guide for more information on ActionScript.

PLUG-INS

If you want to play multimedia on the Internet, you will always need some special "plug-in" for your browser. A plug-in is a special piece of software that can usually be downloaded anywhere and will plug into the browser you are using. For example: If you want to play a movie that was created as Apple QuickTime movie, you will need the QuickTime player. Unfortunately there are a lot of plug-ins available for several file formats:

· Apple QuickTime 

· Microsoft Media Player 

· Headspace Beatnik Player 

· RealPlayer 

· Adobe Acrobat Player 

· Live Audio Player 

· Macromedia Shockwave Flash Player 

· Macromedia Director Player 

This is not a complete list of available plug-ins, but it lists the most common players. A common plug-in is "Macromedia Shockwave Flash Player" which is necessary to view Flash movies. So if your users do have a modern browser, they will not have to download another plug-in unless a new version of Flash is available. Even then, the plug-in is very small (about 300 Kb) and easy to install. With Internet Explorer it can be done automatically after the download, with Netscape it is necessary to start an executable setup program after the download.

Many companies offer specialized tools to animate text or generate animated banners in the specific .swf format. All these tools are not as powerful as the original software from Macromedia, but they are very useful to help with special effects. Especially, when you need a text effect, it is much easier to use a $50 tool like swish ( www.swishzone.com) to build your effect in 10 minutes than doing it by hand in one hour.

GETTING A TRIAL VERSION OF FLASH

You can obtain a 30 day trial version of Flash from Macromedia. The software can be downloaded from: 
http://www.macromedia.com/software/flash/trial/
FLASH TUTORIALS

Flash 5 comes with a good tutorial that is built in to the help menu. If you choose the tutorials from this menu, you will get the first steps to start. The tutorials are all produced in flash, so you can learn these steps interactively.

INTERNET TUTORIALS

After you worked through the Tutorials from Macromedia, you can have a look at other tutorials that are available on the Internet. There are some standard websites that offer loads of material for Flash. Here are just a few of them:

http://www.flashkit.com
http://www.flashplanet.com
http://www.echoecho.com
http://www.trainingtools.com
THE FLASH SCREEN

This is the blank movie screen you get when you first start up flash.

Across the top of the screen is the TIMELINE, which controls the movie’s contents using LAYERS. The contents of the current frame are shown on the stage. The TOOLBOX lets you draw, transform, and edit objects and text.

ACTIVITY 1 – THE USER INTERFACE

Locate the TIMELINE, LAYER 1, TOOLBOX, MENU BAR, FRAMES, STAGE and the PROPERTIES INSPECTOR on the diagram below.
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FRAMES, KEYFRAMES AND FRAME SPEED

The frame speed is set at 12 fps (frames per second). This means that when the movie plays, 12 frames will be shown every second. To make a movie, you add as many frames as you need – for example, if you want your movie to go for 5 seconds, then you insert a keyframe at frame 60 (12framesX5sec=60fps). You can insert ordinary frames, but keyframes allow you to create major changes in the movie.
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As a tip, set up the default first frame with the scene that you want, then insert a keyframe at the end of your movie – an image of the first frame will be placed on all of the other frames!

CREATING ANIMATIONS

When you want objects to move with respect to one another, while the movie is playing, you need to draw each object onto its own layer. This is a bit like making a drawing out of several sheets of clear plastic (layers) for every frame and then overlaying them on top of each other.
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THE TIMELINE
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The timeline shows a lot of information about your movie. It shows each scene, frame and layer that makes up the movie. Clicking on a particular frame changes the Stages display to that frame. Dragging the play head across the frame numbers will change the Stage display from frame to frame. To change the name of a layer, double click on the current layer name.

CHANGING MOVIE PROPERTIES

You can access the Document Properties dialog box by using the menu MODIFY, DOCUMENT or press CTRL J.
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This is where you can change the 

· Background colour.

· The Ruler units.

· The dimensions of the movie – either type these in directly or set it to match the Printer or the Contents to create a Stage just big enough to cover all the elements of the movie.

· The frame rate.

· The default movie settings.

You can also use the PROPERTIES INSPECTOR at the bottom of the screen for the movie you are making.
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To Make the Grid Visible / Not Visible

Choose the menu VIEW, GRID.

To Turn on the Snap to Feature

Choose the menu VIEW, SNAP TO OBJECTS.

Magnifying Objects

To control how much of your movie you can see you can use any of the following methods:

· Use the menus VIEW, ZOO IN / ZOOM OUT / MAGNIFIACTION.

· Use CTRL = (zoom out) or CTRL – (zoom in)

· Use the Zoom Tool and its modifiers = and – from the Tools Box.
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DRAWING WITH THE TOOL BOX

TEXT TOOL

Modifiers section will allow you to change texts:

· Font Type

· Font Size

· Font Color

· Bold/Italic

· Alignment

· Paragraph Settings

PENCIL TOOL

Use this to draw lines and basic shapes.

Modifiers section will give you a selection of:

· Types of Lines to draw (pencil modes): Straighten (will automatically straighten the line when you draw it), Smooth, Ink (like regular drawing), Oval/Circle, Rectangle/Square, & Line

· Line Color

ARROW TOOL

Modifiers Section will contain:

· Magnet - Toggles the Snap Feature (ability to 'snap' objects to a grid or other objects).   Menu: View > Snap

· Smooth/Straighten - Simplifies selected lines or shapes. Menu: Modify > Curves > Smooth or Straighten.

· Rotate - Will display handles around object for rotation ability. Menu: Modify > Transform > Rotate

· Scale/Resize Tool - Will display handles around object for scaling. Menu: Modify > Transform > Scale.

· Line Width

· Line Style - Solid, dashed, dotted, etc.

INK BOTTLE TOOL

Use this to add a line to a shape or modify an existing line.

Modifiers will allow you to:

· Change the line color

· Change the line width

· Change the line style - Solid, dashed, dotted, etc.

BRUSH TOOL

Used to paint filled shapes on your movie

· Paint filled shape (paint normal, paints fills, paint behind, paint selection, and paint inside).

· Brush color to paint with

· Brush size

· Brush Shape

· Lock fill - will connect other paint 'area' as long as they are the same color
PAINT BUCKET TOOL

Fills unfilled outlines and changes the fill color of existing fills or shapes

· Fill color

· Gap size (Controls how large gaps can be before they are not recognized as one fill shape)

· Lock Fill ( can 'attach' one fill to another, and appear to be part of one shape)

· Transform Fill (ability to rotate, skew, and scale fills)

ERASER TOOL

Deletes portions of lines and shapes in the movie

· Eraser Mode ( Control what can be erased -- normal, erase fills, erase lines, erase selected fills, erase inside)

· Faucet (Erases entire lines or fills).

· Eraser Shape

DROPPER TOOL

Picks up a fill or line style when you click on a shape or line. It has no modifiers.

MAGNIFIER TOOL

Gives you the ability to enlarge or reduce the view of the movie.

If you drag a rectangle around a certain area it will zoom in to that specific area. Using the alt key (Windows),

Option key (Mac) will allow you to toggle between Zoom in and Zoom out.

LASSO TOOL

Selects irregular areas of a current frame. You can split up shapes or select a portion of a line.

· Magic Wand (Select portion of bitmap to use as a fill)

· Magic Wand Properties

ACTIVITY 2 – USING THE DRAWING TOOLS

1. Start a new movie by using the FILE NEW menu.

2. Use the zoom tool (magnifying glass) on the tool bar to shrink the editing area so that you can see the entire rectangle. You will probably have to use the modifier control to get it to shrink. 

3. Go to the menu bar and choose MODIFY, DOCUMENT (or press CTRL J). This will open the Document Properties dialog box so that we can change the background colour. Choose a background colour.

4. Experiment with each of the tools to see what each one does.

5. Close the file.

ACTIVITY 3 – DRAWING A FISH POND

1. Start a new movie by using the FILE NEW menu.

2. Use the zoom tool (magnifying glass) on the tool bar to shrink the editing area so that you can see the entire rectangle. 

3. Go to the menu bar and choose MODIFY, DOCUMENT (or press CTRL J). This will open the Movie Properties dialog box so that we can change the background colour. Choose a blue or green background colour to look like water.

4. Choose the Brush Tool and change its size to the fourth down on the drop list. Change the fill colour to a dark green. Draw a few vertical wavy lines to represent weeds.
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Double click Layer 1 and name it BackWeeds.

6. Add another layer, double click Layer 2 (or the newly added layer) and change its name to Fish.

7. Select the menus FILE, IMPORT TO LIBRARY, navigate to the ANIMATED GIFS folder in our class folder on V drive and find the animated gif file FISH_eo.GIF. Open the Library window by selecting the menu WINDOW LIBRARY (or F11).

8. Find the Fish_eo.gif file and drag it to the right hand side of the Stage. Adjust its size if necessary using the menus MODIFY, TRANSFORM, SCALE. You may not need to change it.

9. Add another layer, change the Fill colour to a slightly lighter shade of green and draw some more weeds with the Brush tool. Double click Layer 3 and change its name to Weeds.

10. Now to add some movement. Go to Frame 30 and click in the grey cell for the Weeds layer and press F6 to insert a Keyframe.

11. Insert a keyframe in Frame 30 for the Fish layer as well. With Frame 30 still selected, move the Fish to the Left-hand side of the Stage.

12. Click on Frame 1 in the Fish layer and select the menus INSERT, CREATE MOTION TWEEN. This will smooth movement of the fish from Frame 1 to Frame 30. You can also use the right-click menu to find CREATE MOTION TWEEN.

13. Save the file as Fish Pond using the menus FILE, SAVE or FILE, SAVE AS.

14. Press CTRL ENTER or select the menus CONTROL, TEST MOVIE to look at your Fish in action.

If you experience any difficulties, either back track to the step where you think you went wrong or delete the file and redo the exercise.

EXTENSION:


Try adding some more fish – each on their own layer so they can move independently.

TWEENING – SMOOTHING CHANGES FROM FRAME TO FRAME

Tweening, or in-betweening, is a feature that smoothes changes from frame to frame between the first frame and the last frame of a particular animated sequence. These changes can be in:

· Location or rotation (Motion Tween)

· Colour (Tint Tween)

· Transparency (Alpha Tween).

· Shape (Shape Tween).
USE THESE GENERAL INSTRUCTIONS WHEN YOU WANT TO CREATE TWEENING.

TO CREATE A MOTION TWEEN:

1. Place a symbol or grouped object on the stage. Note – if you draw an object, group it if necessary then make it into a symbol using the menus INSERT, CONVERT TO SYMBOL (F8).

2. Click on the Timeline where you want the tween to end and insert a keyframe (F6).

3. Move the position of the object on the last frame of the sequence.

4. Click on Frame 1 (or the first frame of the sequence) and select INSERT, CREATE MOTION TWEEN. An arrow should appear on the timeline. If you get a broken line, then you have probably not converted your drawing to a symbol – INSERT, CONVERT TO SYMBOL or F8.

TO MAKE AN OBJECT ROTATE

1. Set up the motion Tween as above.

2. Go to the last frame in the sequence.

3. Use the Frame Panel (CTRL F) to change the Rotate property to CW (clock wise) or CCW (counter clock wise) of the object. Also set the number of times to rotate.

ACTIVITY 4 – CREATING A SIMPLE MOTION TWEEN

1. Start a new Flash file.

2. Zoom out so that you can see the entire stage.

3. Select the menus FILE, IMPORT TO LIBRARY, and import the Wyvern picture in your class Flash folder on the network.

4. Select the graphic with the arrow tool. Make the imported graphic into a graphic symbol using the menus INSERT, CONVERT TO SYMBOL (F8) – use an appropriate name like “Wyvern”.

5. Move the graphic to the right side of the stage. This is the starting position.

6. Click on the Timeline on Frame 36 (for a 3 sec movie) and insert a keyframe (F6).

7. With Frame 36 still selected, move the graphic to the left of the stage. This is the ending position.

8. To make the in-between frames (2 to 35) show intermediate positions for the graphic, you need to turn on the tweening. Click on Frame 1 and select INSERT, CREATE MOTION TWEEN. An arrow should appear on the timeline. 

9. Test your movie by pressing CTRL ENTER. The Wyvern should move across the screen.  Close the Movie viewer by clicking the small x in the top right corner.

Not very exciting?? Let’s add some rotation.

10. Click on Frame 1 to select it. Press CTRL F or use the menus WINDOW, PANELS, FRAME to open the Frame properties tab. 

11. Select CW from the drop down list next to ROTATE. CW is clockwise, CCW is counter clockwise or the other direction. Enter the number of times to rotate – try 3.

12. Test your movie again by pressing CTRL ENTER. The Wyvern should now move across the screen rotating as it goes. 

13. Close the Movie viewer and save the movie as MotionTween.fla.

ACTIVITY 5 – CREATE A CRAZY FLYING MACHINE

1. Start a new Flash file.

2. Zoom out so that you can see the entire stage.

3. Select the menus MODIFY, MOVIE and change the background colour to a light blue for the sky.

4. Change the name of layer one (double click) to CloudsBehind and create two or three fluffy white clouds using the Brush tool and an oval modifier from the lower part of the panel. 

Note that if you want the clouds to move on this layer, you will need to convert them to symbols (Insert menu or F8) and create a motion tween. If you want to move the clouds independently, each cloud would need to be on a separate layer with its own motion tween.

5. Add a new layer and call it Biplane.

6. Use the menus WINDOW, COMMON LIBRARIES, MOVIE CLIPS to locate the BIPLANE, then drag an instance of the clip to the stage. 

7. Resize the biplane if necessary using the menus MODIFY, TRANSFORM, SCALE. Resizing handles will appear on the biplane. Adjust the size as required and move the biplane to the left side of the stage – this is the starting position.

8. Add a new layer and call it CloudsInFront.

9. Create two or three fluffy white clouds using the Brush tool and an oval modifier from the lower part of the panel. Convert the clouds to symbols using the Arrow tool and the INSERT menu.

You should now have the scene set for Frame 1 (starting positions for objects). You now need to add keyframes and create motion tweens for those objects you wish to move.
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10. Click on the Timeline on Frame 36 (for a 3 sec movie) and insert a keyframe (F6) for each of the three layers.

11. With Frame 36 selected for each layer (one at a time), move the objects to their corresponding ending positions.

12. To turn on the tweening for each layer, click on Frame 1 and select INSERT, CREATE MOTION TWEEN. An arrow should appear on the timeline for each layer. 

13. Test your movie by pressing CTRL ENTER. The Biplane should move across the screen with the clouds moving as well.  Close the Movie viewer by clicking the small x in the top right corner.

Still not very exciting?? Let’s add some rotation again.

14. Click on Frame 1of the Biplane layer to select it. Press CTRL F or use the menus WINDOW, PANELS, FRAME to open the Frame properties tab. 

15. Select CW from the drop down list next to ROTATE. Enter the number of times to rotate – try 4.

16. Test your movie again by pressing CTRL ENTER. The Biplane should now move across the screen rotating as it goes – out of control. 

17. Close the Movie viewer and save the movie as Biplane.fla.
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TO CREATE A TINT TWEEN:

1. Place a symbol or grouped object on the stage. Note – if you draw an object, group it if necessary then make it into a symbol using the menus INSERT, CONVERT TO SYMBOL (F8).

2. Click on the Timeline where you want the tween to end and insert a keyframe (F6).

3. Change the colour of the object by selecting MODIFY, INSTANCE (CTRL I). Click on the EFFECT tab and choose TINT from the drop down menu. Select the desired colour.

4. Click on Frame 1 (or the first frame of the sequence) and select INSERT, CREATE MOTION TWEEN. An arrow should appear on the timeline.

ACTIVITY 6 - TINT TWEEN / FLASHING COLOURS

1. Draw a rectangle on the stage and fill it a blue colour. 

2. Make it into a symbol using the menus INSERT, CONVERT TO SYMBOL (F8).

3. Click on the Timeline at frames 5, 10, 15, 20 and 25,  and insert a keyframe (F6) at each position.

4. Change the colour of the object at each keyframe by selecting MODIFY, INSTANCE (CTRL I). Click on the EFFECT tab and choose TINT from the drop down menu. Select the desired colour. The colours should be Frame 1 – Blue, Frame 5 – Green, Frame 10 – Yellow, Frame 15– Orange, Frame 20 - Red, Frame 25 – Purple.

5. Click on Frame 1 (or the first frame of the sequence) and select INSERT, CREATE MOTION TWEEN. An arrow should appear on the timeline.

6. Repeat step 5 for frames 5, 10, 15 and 20.

7. Add another layer and call it Name. Use the Text tool to type your name then position it over the rectangle.

8. Play your Movie (CTRL ENTER). Close the Movie viewer and save the file as TintTween.


TO MAKE AN OBJECT APPEAR OR DISAPPEAR:

1. Place a symbol or grouped object on the stage. Note – if you draw an object, group it if necessary then make it into a symbol using the menus INSERT, CONVERT TO SYMBOL (F8).

2. Click on the Timeline where you want the tween to end and insert a keyframe (F6).

3. Change the transparency of the object by selecting MODIFY, INSTANCE (CTRL I). Click on the EFFECT tab and choose ALPHA from the drop down menu. Use the slider to select the desired transparency.  0% is fully transparent or invisible, 100% is opaque or solid.

4. Click on Frame 1 (or the first frame of the sequence) and select INSERT, CREATE MOTION TWEEN. An arrow should appear on the timeline.

ACTIVITY 7 – FADING NAME

1. Using the TintTween.Fla file made in Activity 6, you are going to add an Alpha (or transparency) Tween to your name layer. 

2. Select your name on Frame 1 and make it into a symbol using the menus INSERT, CONVERT TO SYMBOL (F8).

3. Change the transparency of the object at Frame 1 by selecting the EFFECT tab and choose ALPHA from the drop down menu. Slide to select the desired transparency – in this case, 0%. Go to the last frame of the sequence (Frame 25) and change the transparency or Alpha to 100%.

4. Click on Frame 1 (or the first frame of the sequence) and select INSERT, CREATE MOTION TWEEN. An arrow should appear on the timeline.

5. Play your Movie (CTRL ENTER). Close the Movie viewer and resave the file as TintTween.

MORPHING ONE SHAPE TO ANOTHER:

Flash can be used to create the illusion of changing one shape into another. This is called morphing or Shape Tweening. 

1. Draw a simple object on the stage. More complex drawings require shape hints to be inserted at critical points on the object. At this stage just draw a circle or a rectangle. 

2. Click on the Timeline where you want the tween to end and insert a blank keyframe using the INSERT menu (or F7).

3. Draw another object – make sure that it is a regular shape.

4. Click on Frame 1 (or the first frame of the sequence) and double click. To open the Frame dialog box. Click the FRAME tab.

5. Choose SHAPE from the drop down list for Tweening.

6. An arrow should appear on the timeline.

ACTIVITY 8 – SHAPE SHIFTING

1. Start a new Flash file.

2. Draw a circle in the middle of the stage. Fill it with a colour of your choice.

3. Click on the Timeline at Frame 24 and insert a blank keyframe using the INSERT menu (or F7). It is important that it is a blank keyframe.

4. Draw rectangle at Frame 24 in roughly the same position as the circle. Change the fill colour.

5. Click on Frame 1 (or the first frame of the sequence) and double click. To open the Frame dialog box. Click the FRAME tab.

6. Choose SHAPE from the drop down list for Tweening. The timeline should go green and an arrow appear to indicate shape tweening.

7. Test your movie by pressing CTRL ENTER.

8. Close the movie and save it as ShapeTween.fla.

9. Go to Frame 48 and insert another blank keyframe. Draw another regular shape – eg a simple star. Fill it with another colour.

10. Go to Frame 24 and turn on the Shape Tweening on the Frame tab as before.

11. Test the movie again, close the viewer and resave the file.

ACTIVITY 9 - SPINNING PHOTOGRAPHS

1. In a new Flash file change the background to a blue colour. 

2. Rename Layer 1 to Photo1.
3. Create a layer for each photo you intend to import – say 4?

4. Click on FRAME 1 in the Photo1 layer, and then import the first photo by using the FILE, IMPORT menu. 

5. Make each Photo a symbol by selecting the menu INSERT, CONVERT TO SYMBOL (F8). Choose Graphic and name the symbol Photo1, Photo2, etc.

6. Import the other photos and put each on its own layer.

7. Move the photos to their starting positions in Frame 1 for each layer.

8. Resize the photos if necessary using the MODIFY, TRANSFORM, SCALE menu. Click and drag to resize.

9. Click on FRAME 40 on each layer and press F6 to insert keyframes.

10. Move the photos to their ending positions.

11. Go back to FRAME 1 on each layer separately, and then select the menus INSERT, CREATE MOTION TWEEN.

12. Turn on the CW (clockwise) rotation for each layer on Frame 1 using the FRAME panel.

13. Press CTRL-ENTER to play your animation. Save the file as PhotoSpin.

14. Add another layer called Title. Use the Text tool to create the title My Photographs in the centre of the stage. Change the properties of the text so that it is about 40 points and choose a suitable colour on the Character panel.

15. Press CTRL-ENTER to play your animation again. Resave the file as PhotoSpin.

BUT – how do we STOP the animation so that we can look at the photos? Easy – add a frame action to the last frame of each layer.

16. Double-click on the last frame of the first layer and the Frame Actions dialog box will appear. Choose Basic Actions, and on the list double-click on STOP. A small a will appear on the timeline to indicate that the frame has an action on it. 

17. Repeat step 16 to add actions to the other Photo layers.

18. Press CTRL-ENTER to play your animation again. Resave the file as PhotoSpin.

WORKING WITH TEXT

As you have seen in an earlier activity, the Text tool enables you to create text and the Character panel allows you to change the properties of the text – like bold, italics, colour, font, size etc.

Once your text has been created you can then choose to leave it on the stage as a label (an object that does not change throughout the movie), or you can convert the text into a symbol so that it can be animated in some way.

Another useful feature for manipulating text is Break Apart. This allows you to break apart the individual letters in a word created using the Text tool so that they can be cut and pasted onto separate layers, and thus animated separately. This feature is handy if you want an effect where the letters for a title fly in from different directions and form the word in the last keyframe. 

BREAKING APART TEXT

A general approach to break apart text would be to:

1. Create the original text object on the stage and format it as desired using the Character panel.

2. Add a new layer for each letter in the word or words. For example – 3 layers for each of the 3 letters in the word FUN. Name each layer appropriately ( f, u and n for example).

3. Go back to the layer containing the original word and select the text object with the arrow tool.

4. From the MODIFY menu select BREAK_APART (or CTRL B). The letters will now be separate, but since all of them will still be selected, you will need to click outside the word, then reselect the first letter. For letters like I you will need to use the SHIFT key to select all parts of the letter. Then group the parts using MODIFY GROUP (CTRL G).

5. Once the letter (or group) has been selected, go to INSERT, CONVERT TO SYMBOL (F8) to make it a symbol. This is necessary for animation. Choose GRAPHIC as the object type and give it a suitable name – for example F.

6. Cut the symbol from the original layer and paste it on its own layer prepared earlier.

7. Repeat steps 4, 5 & 6 until all letters have been pasted as symbols onto their own layers.

8. Delete the original word’s layer, making sure that each letter has been moved to its own layer.

9. In Frame 1 for each letter layer move the letter to the desired starting position, and change the tint or the transparency (alpha %) as required.

10. Insert a keyframe where you want the animated sequence to finish and reposition or change the properties as you want the letter to end up. Typically you would want the letters to be fully opaque (100% alpha) and positioned so that they spell the original word or words.

11. Go back to frame 1 (or the first frame of the sequence) and use INSERT, CREATE MOTION TWEEN or make it a Tint tween as necessary.

12. Add a STOP action to all layers in the last frame to stop the animation so that you can read the word.

Note – this process is tricky if you are not carefully meticulous at following instructions. Most people only use the technique on short words because of this, but the process can be used on words of any length if you have patience.

ACTIVITY 10 – FLASH BREAK

1. Start a new Flash file.

2. Use the Text tool to type the word FLASH in the middle of the stage. Change the size to about 40, the Font to Comic Sans MS, with a colour of your choice.

3. Add a new layer for each letter– in this case this is 5 layers for each of the 5 letters in the word FLASH. Name each layer appropriately ( f, l, a, s and h).

4. Go back to the layer containing the original word and select the text object with the arrow tool.

5. From the MODIFY menu select BREAK_APART (or CTRL B). The letters will now be separate, but since all of them will still be selected, you will need to click outside the word, then reselect the first letter. 

6. Select the F, then go to INSERT, CONVERT TO SYMBOL (F8) to make it a symbol. Choose GRAPHIC as the object type and give it a suitable name – for example F.

7. Cut the symbol from the original layer (CTRL X and paste it (CTRL V) on its own layer prepared earlier.

8. Repeat steps 4, to 7 until all letters have been pasted as symbols onto their own layers.

9. Delete the original word’s layer, making sure that each letter has been moved to its own layer.

10. In Frame 1 for each letter layer move the letter to the desired starting position, and change the tint or the transparency (alpha %) as required.

11. Insert a keyframe where you want the animated sequence to finish (Frame 36) and reposition each letter so that they spell the original word FLASH.

12. Go back to frame 1 and use INSERT, CREATE MOTION TWEEN

19. Add a STOP action to all layers in the last frame to stop the animation so that you can read the word. Double-click on the last frame of the first layer and the Frame Actions dialog box will appear. Choose Basic Actions, and on the list double-click on STOP. 

13. Test the movie with CTRL ENTER, close the viewer and save the file as FlashBreak.


EXTENSION

Repeat the last activity using your own name. Try getting the letters to spin and change colour from red to blue.

MAKING A SCENE

You should now be ready to use the features you have learnt so far to make a scene. The next activity uses a number of layers for a background, planetscape and spaceship to create an animation of alien ship landing.

ACTIVITY 11 – ALIEN INVASION

1. Get a new FLASH file.

2. Use the MODIFY, MOVIE menu to change the background colour to BLACK.

3. Use the PAINTBRUSH tool to draw some dots for stars. Change the colour to white and the size to a small dot first.

4. Name the layer STARS. Turn off the layer by clicking on the dot under the eye for that layer only. This will avoid accidentally selecting stars as you work with the UFO on the next layer.

5. Insert a new layer and call it UFO.

6. Change the FILL tool to a gradient colour and draw two ellipses or ovals to create you UFO.

7. Use the SELECT tool to select your UFO – draw a box around it. Choose MODIFY, GROUP.

8. Select INSERT, CONVERT TO SYMBOL, call it UFO, then click OK.

9. Move the UFO to the top right of the screen and use MODIFY, TRANSFORM, SCALE to make the UFO smaller.

10. Click on FRAME 50 and insert a keyframe F6 on both layers.

11. Move the UFO in FRAME 50 to the lower left corner and make it larger.

12. Go back to FRAME 1 on the UFO layer and select INSERT, CREATE MOTION TWEEN.

13. Play your movie with CTRL-ENTER. Close the viewer window and save the file as AlienInvasion.fla.

EXTENSION

· Add another layer between the stars and the ufo and create a planetscape to land on.

· Try animating some of the stars.

· Use the image of Marvin the Martian supplied and animate it coming out of the spaceship when it lands.

· Create a satellite or a rocket that arcs over the sky on its own layer.

PUTTING IT ALL TOGETHER

The next activity is a long one, so save frequently as you work. It puts together a lot of the skills covered in this booklet. Be patient and follow the instructions carefully – the quality of your resulting animation depends on this.

ACTIVITY 12 – FISH TANK

This exercise has been adapted from a tutorial that appeared in the Web Design Special edition of Computer Arts Magazine in 2000. The exercise has been simplified to make it easier to follow as the version in the magazine was brief and intended for experienced users of Flash.

STEP 1 – SETTING UP THE MOVIE

· Go to the MODIFY menu and choose MOVIE.  A dialog box like the one shown below should appear.

· Set the movie WIDTH to 300 pixels and the HEIGHT to 200 pixels.  This is so that it will fit well in a browser window.

· Click on the BACKGROUND COLOUR, and change it to a pale blue.  Click OK.

· Go to MODIFY, LAYER (or double click the layer name) and call the layer “base”.

STEP 2 – DRAWING THE WATER

· Double-click on the MAGNIFIER tool to zoom out, so that you can see all of the movie.
· Insert a new layer by choosing INSERT LAYER from the menu, or click the Insert Layer tool in the layer box. 
· Go to MODIFY, LAYER (or double click the layer name) and call the layer “water”.
· Use the PENCIL tool from the toolbar to draw some blue waves as shown.
· Make sure that the “water” shape is an enclosed space by joining the line down around the bottom of the screen and back up to where you started drawing.  This is so the Fill tool will work.

· Fill the water shape with a dark blue colour.

· Save your file as FishTank.
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STEP 3 – ADDING A NEW LAYER FOR THE “SAND”

· Add a new layer above the existing layer by choosing INSERT, LAYER.  You will see a new layer appear in the Timeline.

· Go to MODIFY, LAYER (or double-click the layer name) and type “sand” in the name box.  Click OK.  

Any objects inserted into the sand layer will appear to float over any objects in the lower layers.

· Change the PENCIL tool colour to yellow and draw an enclosed shape for the sand at the bottom of the “water”.

· Change the FILL tool colour to yellow and fill the “sand” area.

· Save the file.
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STEP 4 – ADDING THE FISH

· Insert a new layer and call it “fish”.  Make sure that each new layer is on top of the previous layer.

· Select the FILE, IMPORT menu and import the “fish” graphic file from the class folder on the network drive.

· Click on the fish with the ARROW tool to select it.

· Go to INSERT, COVERT TO SYMBOL. Any object you want to animate should first be converted to a SYMBOL.

· Reduce the size of the fish by using the MODIFY, TRANSFORM, SCALE menu.

· Move the fish to the right hand side of the water.
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STEP 5 – ANIMATING THE FISH

· In the FISH layer, click into frame 50 on the timeline and insert a keyframe using the INSERT KEYFRAME menu (or F6).  A grey band should appear on the timeline between frames 1 and 50 – this indicates that the image of the fish will appear in each of these frames.

· To add animation, we need to make a change to the image from one keyframe to the next.  In frame 50 on the Fish layer, move the fish to the left hand side of the water.

· Click on Frame 1 on the Fish layer, and choose MODIFY FRAME (or double-click the frame) to open the frame editing box.

· Click on the FRAME tab and choose MOTION from the drop-down list.  An arrow appears on the timeline.  This indicates that the frames between 1 and 50 will be tweened.
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STEP 6 – TESTING THE MOVIE (OR ANIMATION)

· Add keyframes to frame 50 in each of the other layers (F6).

· Test your movie by choosing CONTROL, TEST MOVIE, or press CTRL-ENTER.

· Close the Player window that appears.

STEP 7 – ADDING A MESSAGE

· Insert a new layer and call it “text”.

· Create a message - select the TEXT tool, choose 20 points as the font size from the tool bar, and then type “NEED SOME FISH FOOD?”.

· Select the text object with the ARROW pointer tool and then go to MODIFY, GROUP to group the text.

· Go to INSERT, CONVERT TO SYMBOL.  Call the text object “message”.  

· Add a keyframe to frame 50 on the text layer.

· Double-click frame 1 on the text layer to open the Frame editing box.

· Click the Frame tab and choose Motion from the Tweening list.

· Click the Effect tab and choose Alpha from the list.  Set the percentage to O%.  This will make the text fade in over the 50 frames of the animation.

· Save the file, and then play it by pressing CTRL-ENTER.

EXTENSION

· Add another layer with the words FISH TANK, break the letters apart and create the effect of the letters appearing from out of the water at 20% alpha and forming the fully visible (100% alpha) words Fish Tank on the last frame where the animation stops.

· Add more fish and animate each one separately on a different layer.

· Add a layer and draw some weeds or underwater vegetation.

TWEENING MOTION ALONG A PATH 

Motion guide layers let you draw paths along which tweened instances, groups, or text blocks can be animated. You can link multiple layers to a motion guide layer to have multiple objects follow the same path. A normal layer that is linked to a motion guide layer becomes a guided layer. 

TO CREATE A MOTION PATH FOR A TWEENED ANIMATION: 

1. Create a motion-tweened animation sequence.

2. Right-click the layer containing the animation and choose Add Motion Guide from the context menu. Flash creates a new layer above the selected layer with a motion guide icon to the left of the layer name.
Select the layer containing the animation and either select the menus INSERT, MOTION GUIDE or 
3. Use the Pen, Pencil, Line, Circle, Rectangle, or Brush tool to draw the desired  path. 

4. Snap the center to the beginning of the line in the first frame, and to the end of the line in the last frame.


Note: Drag the symbol by its registration point (small circle) for best snapping results.

5. To hide the motion guide layer and the line so that only the object's movement is visible while you work, click in the Eye column on the motion guide layer.

6. The group or symbol follows the motion path when you play the animation. 

ACTIVITY 13 – CREATING A BOUNCING BALL

In this activity you will make a ball follow a path so that it appears to bounce.

1. Get a new Flash movie.

2. Draw a circle on the left hand side of the stage and fill it with a gradient fill.

3. Double-click the ball with the arrow tool to select it and then convert it to a symbol with F8.

4. Insert a keyframe at Frame 10 and move the ball to the right hand side of the stage.

5. Go back to Frame 1 and create a motion tween (right-click and select from menu).

6. Click on the name Layer 1 to select the layer.

7. Click the Insert Motion Guide layer button (or right-click and select it).

8. Draw a curving path for the bouncing ball with the pencil tool on the guide layer.

7.  On Layer 1 drag the ball so that its registration point (small cross) snaps onto  the center to the beginning of the line in the Frame 1, and to the end of the line in the Frame 10.

8.  Press CTRL ENTER to test your movie. Save the file as BouncingBall.fla.

ACTIVITY 14 – CREATING FISH BUBBLES

In this activity you will further develop the aquarium created in Activity 12 by using a path animation to make a bubble appear to come from the fish’s mouth and meander to the surface of the water. 

1. Make sure that FishTank.fla from Activity 12 is open.

2. Add a new layer and make sure that it is moved to the top of the other layers. Name this layer fish2.

3. Select the menus WINDOW, LIBRARY to open the Library window. The fish graphic should be in the list of objects. In Frame 1 on the Fish2 layer, drag an instance of the fish to the left of the screen – so its not visible in the viewing area. Zoom out if necessary.

4. Select MODIFY, TRANSFORM, FLIP HORIZONTAL to turn the fish around.

5. Insert frames using F5 on the fish2 layer up to Frame 49, then insert a keyframe at Frame 50. We will not move the second fish at this frame.

6. Insert more frames using F5 on the fish2 layer up to Frame 69, then insert a keyframe at Frame 70. 

7. On Frame 70 move the second fish so that the eye of the fish sits just underneath the question mark of the text.

8. Go back to Frame 50 on the fish2 layer and select INSERT, CREATE MOTION TWEEN.

9. Insert more frames using F5 on the fish2 layer up to Frame 89, then insert a keyframe at Frame 90. 

10. Insert a new layer above fish2 and name it bubble. 

11.  Insert a keyframe at Frame 70 on the bubble layer.

12.  Open the Stroke panel and change the stroke size to 0.5 with the slider. 

13.  Select the Circle tool. Turn off the fill colour and make the stroke colour a light yellow on the Tool Box.

14. On the bubble layer at Frame 70, draw a small bubble near the fish’s mouth with the Circle tool. Select the bubble with the arrow tool and select INSERT, CONVERT TO SYMBOL (f8).

15.  Insert a keyframe at Frame 90 on the bubble layer.

16.  Move the bubble on Frame 90 to the surface of the water

17.  Select the bubble layer by clicking once on its name. Click the Add Motion Guide button in the frames box or right-click and choose ADD MOTION GUIDE.

18. On the motion guide layer use the Pencil tool to draw a curved path for the bubble to follow from the fish’s mouth to the surface of the water. 

19.  Select the bubble on Frame 70 of the bubble layer and move it so that it snaps to the start of the line.

20.  Select the bubble on Frame 90 of the bubble layer and move it so that it snaps to the end of the line.

21.  Add a STOP action to all layers in the last frame to stop the animation so that you can read the word.

22. Press CTRL ENTER to test your movie.

NOTE: if the bubble does not follow the path, try snapping the bubble onto the ends of the path again. It needs to be snapped on propertly or it will not follow the path.

22. Save the movie.

TO FIND OUT MORE ABOUT THE MANY FEATURES OF FLASH – EXPLORE SOME OF THE RESOURCES LISTED AT THE BEGINNING OF THIS BOOKLET.

Lorette Dobb


Kingswood College, 2005
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